DIGITAL ARCHIVING OF AUDIO CONTENT
Using WINISIS and Greenstone Software

2009

A Manual for Community Radio Managers
K. Rajasekharan and K. M. Nafala
Editor: Bimal Kanti Sen
Production Editor: Anup Kumar Das

© UNESCO 2009

ISBN: 978-81-89218-27-0

Acknowledgments

- UN Solution Exchange India - ICT for Development Community
- Greenstone Support for South Asia

This publication may be reproduced in any media appropriately acknowledging UNESCO and the authors.

Design, Typesetting & Graphics: Nikhil Offset Printers, New Delhi

Published by:
Communication and Information Sector
United Nations Educational Scientific & Cultural Organization (UNESCO)
UNESCO House
B-5/29, Safdarjung Enclave
New Delhi-110029, India
Phone: +91-11-26713000
Fax: +91-11-26713001/26713002
Email: newdelhi@unesco.org

Disclaimer
The authors are responsible for the choice and the presentation of the facts contained in this publication and for the opinions expressed therein, which are not necessarily those of UNESCO and do not commit the Organization. The designations employed and the presentation of materials throughout the publication do not imply the expression of any opinion whatsoever on the part of UNESCO concerning the legal status of any county, territory, city or area or of its frontiers or boundaries.

978-81-89218-27-0
Knowledge societies are about capabilities to identify, produce, transform, disseminate, store and use information to build and apply knowledge for human development. This implies respect for a set of principles and priorities, such as freedom of expression; universal access to information and knowledge; respect for human dignity and cultural and linguistic diversity and access to quality education.

Universal access to information and knowledge lies in UNESCO’s overall mandate to promote the free flow of information by word and by image and thus to place information and knowledge at the doorsteps of communities. UNESCO strives to forge an enabling environment to facilitate and open up avenues for universal access to information and knowledge.

In this context, UNESCO gives high priority to promoting universal access to knowledge and information in the public domain as key factors to development. Research shows that technology that facilitates access to relevant and valuable information applications, services and content is most relevant to developing countries. ICT is a catalyst for the achievement of the development goals because of its potential to facilitate access to knowledge and other global public goods. However, the role and value of public domain information, especially of information produced by the public sector, is not widely enough addressed and is generally poorly understood.

UNESCO attaches great importance to providing and strengthening communication and information facilities, particularly at the level of local communities. Such facilities offer basic tools for introducing and managing community-centred development and change. Community media is an effective mode of mass communication involving members of local communities, touching lives of millions of marginalized and remotely located communities. Community radio helps to bridge the knowledge barriers of disadvantaged and poor communities in developing countries where limited functional literacy, limited access to health, food and social securities hinder human development.

While free and open source software (FOSS) helps digital inclusion of citizens in developing countries by bringing within easy reach the socially useful applications, UNESCO’s information processing tools help many grassroots institutions in
disseminating information to local communities. Digital archive of a community radio station will be a kind of knowledge repository that contains collective wisdom of indigenous people, communities and institutions in the region.

The South Asia sub-region is now at the nascent stage of community radio development, with the introduction of policy frameworks in India, Nepal and other countries. Community radio has a great development potential across the sub-region with ever increasing number of community radio stations. To maintain an archive of broadcasted contents is a legal obligation as a self-regulatory mechanism, however many stations are not equipped for doing this. Also community radio stations need to reuse and re-broadcast many of their archived contents.

This publication has its genesis in the recommendations and proceedings of the UNESCO-supported two national events entitled respectively 'National Consultation on Community Radio for Practising and Potential Community Radio Operators in India' and 'National Consultation to Review Community Radio in Nepal', where community radio station managers felt the importance of archiving digital audio contents.

The publication is a self-instructional handbook aimed at helping managers of community radio stations, FM radio stations, public service broadcasting agencies and any other organisations that deal with audio files in creating prototype archives of digital audio documents. In line with the needs of the community, the manual guides users in creating their proper archives with stable, free software like WINISIS, GenISIS and Greenstone. The book also mentions the URLs from where these software can be downloaded from.

This document can be considered as an authoritative self-instructional manual for digital archiving of multimedia contents and more specifically for community radio contents. We hope that the manual users will find it helpful in their daily work.

Iskra Panevska
Adviser in Communication and Information for South Asia
New Delhi
# Table of Content

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foreword</td>
<td>iii</td>
</tr>
<tr>
<td>Preface</td>
<td>vii</td>
</tr>
<tr>
<td>What This Manual is All About</td>
<td>ix</td>
</tr>
<tr>
<td>Chapter 1: Community Radio: An Introduction</td>
<td>1</td>
</tr>
<tr>
<td>Chapter 2: Creation of a Digital Audio Archive using WINISIS</td>
<td>5</td>
</tr>
<tr>
<td>WINISIS: the Database Software used for Archiving</td>
<td>5</td>
</tr>
<tr>
<td>Installation of WINISIS</td>
<td>7</td>
</tr>
<tr>
<td>Creation of an Archive of Audio Documents</td>
<td>11</td>
</tr>
<tr>
<td>Chapter 3: Creating a Front End for the Archive</td>
<td>25</td>
</tr>
<tr>
<td>Installation of Apache Web Server</td>
<td>25</td>
</tr>
<tr>
<td>Installation of GenISISWeb</td>
<td>29</td>
</tr>
<tr>
<td>Creating GenIsisWeb Application</td>
<td>36</td>
</tr>
<tr>
<td>Chapter 4: Creation of a CD-ROM Library of Audio Documents</td>
<td>49</td>
</tr>
<tr>
<td>Creation of a CD-ROM Library with GenIsisCD</td>
<td>52</td>
</tr>
<tr>
<td>Finalize the CD-ROM Application</td>
<td>64</td>
</tr>
<tr>
<td>Modifications to be Made before Finalizing the CD-ROM</td>
<td>66</td>
</tr>
<tr>
<td>Testing the Burned CD-ROM</td>
<td>68</td>
</tr>
<tr>
<td>Chapter 5: Building Up a Digital Library using Greenstone</td>
<td>73</td>
</tr>
<tr>
<td>Installation of the Software</td>
<td>73</td>
</tr>
<tr>
<td>Building up a Collection with GLI</td>
<td>74</td>
</tr>
<tr>
<td>Building the Collection</td>
<td>88</td>
</tr>
<tr>
<td>Annexure</td>
<td>93</td>
</tr>
<tr>
<td>Glossary of Terms</td>
<td>98</td>
</tr>
</tbody>
</table>
The purpose of this handbook is to help the managers of community radio in creating the prototype archive of digital audio documents with stable, free software WINISIS, GenISIS and Greenstone.

The unprecedented growth of digital audio documents makes it necessary to consolidate the growing collection of digital documents into searchable archives or digital library collections for managing and using them properly. The digital document management technologies described in this Manual will make the daily handling of digital audio documents in community radio stations, an easy task.

This self-instructional Manual describes:

1. the method of creation of digital archive with WINISIS software,
2. the creation of a web front-end for the above archives to make it easily usable and accessible over a local area network with GenIsisWeb software,
3. the creation of a CD-ROM library with WINISIS and GenIsisCD software,
4. the creation of a digital library of audio documents with Greenstone digital library software.

The digital archiving or digital library technologies mentioned in the Manual are useful for managing digital audio documents by the managers of community radio stations, FM radio stations, public service broadcasting agencies or other institutions dealing with audio files. The mechanisms described in this Manual can be used for managing not only audio documents, but also other types of digital documents such as text, PDF, HTML and video.

Preface
What This Manual is All About

This Manual is a self-instructional handbook that would help the managers of community radio to create digital archives of audio documents in different electronic formats, ranging from commonly used .WAV documents to .MP3 files to any other format.

Digital audio archiving is the process of building up systematic digital audio collections. It can be considered as an organized digital document management system, for easier searching and retrieval or for making them available on the intranet/internet or on a CD-ROM. Any audio document in the archive can be searched, retrieved, or opened easily and those features make the archive an easily usable one. The addition, replacement or deletion of any existing audio document in the archive can be done with ease. One can, as well, alter any record in the database, whenever necessary.

The digital audio archive can be created with the free software WINISIS as explained in Chapter 2 and it can further be built up into a website like a homepage consisting of a search box, a submit button and other buttons by using GenIsisWeb software as explained in Chapter 3. One can search the archive with any word that appears in the searchable fields of the database of the audio collection and can retrieve, open or save the audio document, as in a website. When a search is made, the database records that match with the search term will be listed in a search-result-display page, with a hyperlink in a field in the displayed record. A click on the hyperlink will open the linked-up document automatically using an appropriate audio player.

The digital audio archive can be configured in such a way that you can enlist all the documents in it sequentially during a search with the word such as list or display, provided that word had been included in every record in the database in any searchable field. The search result for all records in a Demo Digital Audio Archive will appear as in Figure 2.
Chapter 4 of this Manual deals with creation of installable CD-ROM library of audio documents. The audio documents can as well be built into a digital library by using Greenstone digital library software. The method of creation has been described in Chapter 5. Greenstone is the most popular digital document management software compatible with all international standards or protocols.

The software tools mentioned in this Manual for digital archiving are WINISIS, GenISISWeb, GenIsisCD, Greenstone and Apache, which will work even in any low-configuration computer in Windows-based platform.

WINISIS is a versatile textual database software developed by UNESCO mainly for creation of library catalogues. It has been used as the back-end program for the
digital audio archive. The WINISIS database is created first. It is added with a format line to display a hyperlink in its display screen, which links the appropriate document in the digital collection held in the computer.

The digital audio archive allows metadata-based search, retrieval and display of audio documents by a few mouse clicks. The GenISISWeb/GenIsisCD software provides a user-friendly web-front-end and helps publish the archive in intranet or in a CD-ROM without hassles.

![Figure 2: Demo Digital Audio Archive- Search Result Page](http://[image-url])
Those software tools required for creation of audio archives are freely obtainable from the Internet and the website links are provided as footnotes at the appropriate places.
The digital audio document archive can be created in any low configuration computer, with minimum learning and efforts and hence it should be a reasonable choice for the resource-poor managers of community radio in the developing world.

The Manual is expected to be a user-friendly guide to the community radio managers/information professionals/researchers/activists who want to make use of digital audio archiving as a tool for information dissemination, empowerment and development.

### Table 1: Digital Archiving Software (FOSS) Described in this Manual

<table>
<thead>
<tr>
<th>Application Software</th>
<th>Download Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>WINISIS or CDS/ISIS for Windows</td>
<td><a href="http://www.unesco.org/isis/files/winisislicense.html">www.unesco.org/isis/files/winisislicense.html</a></td>
</tr>
<tr>
<td>GenISISWeb</td>
<td><a href="http://www.unesco.org/isis/files/winisis/genisis/web/genisisweb302.exe">www.unesco.org/isis/files/winisis/genisis/web/genisisweb302.exe</a></td>
</tr>
<tr>
<td>GenISISCD</td>
<td><a href="http://www.unesco.org/isis/files/winisis/genisis/cdrom/genisiscd.exe">www.unesco.org/isis/files/winisis/genisis/cdrom/genisiscd.exe</a></td>
</tr>
<tr>
<td>Greenstone</td>
<td><a href="http://www.greenstone.org/download">http://www.greenstone.org/download</a></td>
</tr>
<tr>
<td>Apache Web Server for Windows (HTTP Server)</td>
<td><a href="http://httpd.apache.org/download.cgi">http://httpd.apache.org/download.cgi</a> [download Win32 Binary without crypto (no mod_ssl) (MSI Installer)]</td>
</tr>
</tbody>
</table>
Community radio is a local radio broadcasting system which is owned and managed by the local community and is meant for serving a limited geographical area of around 10 kms radius. It serves as a simple, efficient and cost-effective development communication tool to reach out to the people in the locality, with locally made programmes. The programmes can range from issues on health, education, environment, agriculture, social development to entertainment. Community radio provides programmes that have relevance to the taste of the local audience.

Since 2006, the Government of India, had opened up airwaves for community-based radio broadcasting and allowed non-profit organizations, with minimum three years of registration and service in the community, to broadcast community-based programmes, under due license. Community radio is going to be a reality in many of the places in India in the near future.

Community radio requires a lot of tools and techniques to be on success path. It should have a broadcast studio, a programme studio and a few equipments. The changing technologies, particularly the digital technologies, can make the work in the community radio station easier and effective. Some of the community radio stations, started with modest means, now have many hours of digital audio files of programmes, making it difficult to manage them conveniently. So this Manual facilitates the use of free software WINISIS, GenISIS and Greenstone, that are promoted by UNESCO, to archive, retrieve and use the digital audio documents, in community radio stations, even by any layman.
Digital Audio File Management

Community radio uses sound in divergent forms for broadcast. It can range from the chirping of birds, flowing of a stream, movement of a bullock cart, rain, thunder, gushing out of water from a pump, ticking of a clock, etc. to crying laughter or any verbal utterance as the situation warrants. Community radio can use sound in digital form conveniently, if the audio files are consolidated into easily usable digital archives as described in this Manual.

We can classify the categories of sound as:
- Spoken language
- Music and songs
- Sound effects
- Silence

Radio usually uses written scripts whereas community radio prefers to use spoken dialect particularly the local dialect, familiar to the local audience so as to facilitate easy communication. Music used in programmes helps break the monotony. Elements of sounds, other than spoken words, music and songs, can be used as sound effect to enhance quality of the programmes. A sound of a bell, moving train and other similar sounds can be used as sound effects. Silence, the conspicuous absence of any sound, can also be used as an effect equivalent to that of sound in community radio programmes.

Talks, interviews, dialogues, discussions, plays, features, music programmes, etc. are the various types of community radio programmes. In a community radio station, if sufficient resources are available, a well-equipped digital document archive can be developed as part of the studio for programme production.
Digital Audio Recording

Digital audio recording facilities have become very popular nowadays. It is easy to convert the audio/speech/songs from a microphone into a digital format which can be stored as a computer file, usually in the computer's hard drive or CD-ROM or DVD. There are multitudes of audio file formats. But the most common formats are wave files (.WAV) and MPEG Layer-3 files (.MP3). Some details of the formats are given in the following section.

Digital Audio File Formats

There are multitudes of digital audio file formats and the most common among them are given below:

- **WAV** - the most popular audio file format used mainly in Windows and is commonly used for storing uncompressed sound files. This type of format is large in size and of around 10MB per minute of music. The wave files can be converted to other file format like mp3 to reduce the file size.

- **MP3** - MPEG Layer-3 format is the most popular format for downloading and storing music. The mp3 files are compressed to roughly one-tenth the size of an equivalent WAV file while maintaining good audio quality. The MP3 format is good for large music storage. It is not so good for voice storage.

- **OGG** - a free, open source container format that can be compared to MP3 files in terms of quality.

- **GSM** - is designed for telephony use in Europe and is a very useful format for telephone quality voice. It makes a good compromise between file size and quality. It is very good for voice storage.

- **FLAC** - a lossless audio format. If you compress and covert an audio file to flac and restore it again, it will be a perfect copy of the original. In lossy formats, a small part of the quality is lost. The format FLAC is good for archiving.
- **AU** - a standard audio file format used by Sun, Unix and Java. The audio in AU file format can be compressed.
- **AIFF** - a standard audio file format used by Apple which is like a WAV file for the Mac.
- **VOX** - the VOX format is similar to WAV files except that the VOX files contain no information about the file itself so the codec sample rate and number of channels must first be specified in order to play a VOX file. VOX is a very old file type and is pretty poor.

**Proprietary Formats**
- **WMA** - the popular Windows Media Audio format owned by Microsoft and designed with Digital Rights Management (DRM) abilities for copy protection.
- **AAC** - the Advanced Audio Coding format is based on the MPEG4 audio standard owned by Dolby. A copy-protected version of this format has been developed by Apple for use in music.
- **ATRAC (.WAV)** - the older style Sony ATRAC format. Always it has the .WAV file extension.
- **RA** - a Real Audio format designed for streaming audio over the Internet. The .RA format allows files to be stored in a self-contained fashion on a computer, with all of the audio data contained inside the file itself.
- **DSS** - Digital Speech Standard files are Olympus proprietary format. It is fairly old and poor in utility. It is better to use .GSM or .MP3 whenever the digital audio recorder allows.
- **MSV** - is a Sony proprietary format for compressed voice files. A Sony plugin is needed to load this.
- **DVF** - a Sony proprietary format for compressed voice files which is commonly used by Sony dictation recorders. You might need a Sony plugin to load this.
- **ATRAC (.OMA, .OMG, .ATP)** - the newer style Sony proprietary format designed for mini disc use. It has .OMA, .OMG or .ATP file extension and is similar to MP3. They are rights managed and one cannot open them in any common software programs.
WINISIS software, also known as CDS/ISIS for Windows and developed by UNESCO, is a flexible, easy to use and menu-driven generalized information storage and retrieval software application. Even though the software is designed specifically for creating and managing non-numerical, textual databases such as a library catalogue, it is most suited for managing digital audio documents stored in computer hard disk or other storage media. WINISIS is flexible enough to create any number of databases with completely different data elements. It can be used by anyone having a reasonable computer exposure or experience and hence can be used for easily managing digital documents by community radio managers.

Components of WINISIS Database Software
WINISIS database, as any other database software, can contain any number of records and each record can contain a set of fields such as title of a document and name of creator that you can choose to have. A field, in a record, carries the data element and the value. WINISIS database will have a master file, with .MST extension, containing the entire records in the database. An inverted file, containing all the indexed terms from the data fields along with the master file number (MFN) of the database, generated automatically during database creation, functions as an index to the master file and that mechanism ensures faster retrieval of any record.

---

*A database* is a set of records or pieces of information about entities such as audio, video, or even books, journals, articles, etc. A record is made up of a number of fields. Each field can contain data about particular facts like Title, Singer, Film, Music director, etc. as you choose. One can even create a field for some description about the audio file and that too can be made searchable.
In order to create a WINISIS database with any combination of chosen fields, the following components need to be created.

- **Field Definition Table (FDT):** The FDT defines the fields such as title of a song, name of singer, name of film, format, etc. of the records in the database and their characteristics. FDT determines the structure of data entry worksheet. That means the field name, data type, etc. of the field in the data entry worksheet will be determined by the Field Definition Table.

- **Data Entry Worksheet(s):** The worksheet is the screen layout used to create and/or update the content of the records in the database. The data entry to the database is done by using the worksheet. WINISIS provides a specially designed editor to create the worksheet.

- **Print Format (PFT):** The PFT is the format for display or printing of records. This is the most difficult part in learning the use of WINISIS. The default PFT can be created by WINISIS Print Format Assistant. But if you want to alter the display of elements, you need to learn more about the format terms. Learning the format terms is not so difficult, once you learn the basics.

- **Field Selection Table(s) (FST):** FST defines the fields, from the database, that allow search. Search is made possible by creating an inverted file of terms indexed from those fields chosen for search. If you don't choose any field for search, that field cannot be searched. So select all those fields required to be searched and retrieved.
Installation of WINISIS

Double Click on the Winisis1.5_3.exe file to start its installation.

Figure 2.1: WINISIS Installation File (WINISIS1.5_3.exe)
Then you will get the first screen in the installation process as shown in Figure 2.2.

Click on the Continue button and you will get the window as shown in Figure 2.3.

---

2 WINISIS and associated software are obtainable from UNESCO website http://www.unesco.org/isis/. You can download WINISIS directly from http://www.unesco.org/isis/files/winisislicense.html
Click on the Continue button.

Again click on the Continue button.
Click on the **Continue** button.

Again click on the **Continue** button.
Click on the **Continue** button.

Click the **OK** button and you will be notified the successful installation of the program as shown in Figure 2.9.
Click the **OK** button to finalize the installation.

The next step is the creation of database.

**Creation of an Archive of Audio Documents**

In order to create an archive of digital audio documents, you need to collect the required audio files and place them in a convenient folder in your computer. It can be in any audio file format. Then, create a database of the digital audio documents in WINISIS. The database can have any number of fields as you choose. You can, as well, choose any number as the tag number of each field. The database to be created for demonstration purpose will have the following tags and fields for convenience.

<table>
<thead>
<tr>
<th>Tag</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Title</td>
</tr>
<tr>
<td>20</td>
<td>Singer</td>
</tr>
<tr>
<td>30</td>
<td>Film</td>
</tr>
<tr>
<td>40</td>
<td>Format</td>
</tr>
<tr>
<td>90</td>
<td>Audio File</td>
</tr>
<tr>
<td>100</td>
<td>List</td>
</tr>
</tbody>
</table>

---

1. Before creating the database, remove all the files from the folder C:\WINISIS\DATA. The folder will contain the data files of two sample databases CDS and THES.

2. WINISIS is installed in C:\WINISIS folder by default. Data subfolder holds the Winisis data files. Each Winisis database consists of around 12 files. Files ending with .MST, .FDT, .PFT and .IFP are important data files. Syspar.par is the parameter file that determines many things. Each file in the Winisis must have a numeric tag to identify it. You cannot change the tag number of a field once created, without resorting to import - export process.
Creation of database using WINISIS is very easy and automatic.
Open the WINISIS programme by clicking CDS ISIS for Windows under Start → Program menu.

Then you will get the screen as shown in Figure 2.11.

Click on the Database drop down menu and select New as follows (Figure 2.12).
Figure 2.12: Creating a New Database

Now you will be led to the following screen (Figure 2.13).

Figure 2.13: Naming the Database

Give a database name such as AUDIO and click on the Ok button. Then you will get the following screen (Figure 2.14).

Figure 2.14: Default Field Definition Table
You need to provide the **Tag number** (10, 20, 30, etc) in the Tag box and **Field name** (Title, Singer, Film, etc) of your choice in the Name box and then click the **Add** button every time on completion of each entry.

Beginners may choose **Alphanumeric**[^1] under Type box so that the field can contain alphabetical and numeric data. Click the check box under Rep for multiple occurrences (such as more than one singer) of the field. Ignore the Pattern/Subfields, if you are not dividing the field into subfields.

![Figure 2.15: Field Definition Table](image)

On completing the entering of tag numbers and the name of fields, click the **green arrow button** at the right bottom corner to move on to the next screen.

[^1]: If you choose numeric, you cannot use alphabetical data. It will take numeric data only.

---

---

14
Figure 2.16: Choosing Data Entry Fields

In the screen as shown in Figure 2.16, highlight the fields (on the left pane), which you want to include as the **Data Entry Field** and click on the **double arrow button** in the middle so as to get the field included as a **Data Entry Field**.

Click on the **double arrow button** in the above screen will add all fields in the database as Data Entry Fields and they will appear in the right pane as above, so that you can add data in all fields. Then click on the **green arrow button** to move on to the following screen.

Figure 2.17: Launching Print Format Assistant
Click **Yes** to launch the wizard Print Format Assistant.

![Database Definition - PFT Wizard](image)

**Figure 2.18: Choose a Print Format**

Select the appropriate print format and click **Ok** button to get the print format screen as in Figure 2.19. Decorated format is the preferable choice for the beginners as it appears colourful.

![Data Base Definition - Formats (AUDIO.MST)](image)

**Figure 2.19: Print Format**
Add the following format line in the **print format** statements shown above, in order to create a hypertext link with a set of words such as **Click here**:

**Link ('Click here'), 'OPENFILE ', v90**

Ensure to provide a space between the OPENFILE command and the single quote, and the command OPENFILE should be in upper case as shown above. Instead of the set of words Click Here, you can use any other words as a link in the field.

The meaning of the command is that, when you click on the link with the set of words 'Click here', the click will automatically result in playing the audio file denoted in the field V90, in an audio player.

Click the **green side arrow** button to move ahead and you will be asked whether to launch the Dictionary Assistant.

The resultant print format would appear as in Figure 2.20.

![Figure 2.20: Modified Print Format](image)

Click **Ok** to move on to the next screen (Figure 2.21).

---

*We have chosen the words Click here as the link. The hyperlink from the words Click here will be cross-linked to the full text document, if the full path or location of the document in the computer, is provided in a field. Choose **Tag 90** with field name **Audio File** for giving the full path. The format line given above should also be added to the print format.*
Click Yes (Figure 2.21) to launch the Dictionary Assistant. Dictionary Assistant will help you in selecting the fields for indexing and the indexing technique for creation of Inverted File Index. You will then get the following screen (Figure 2.22).

Put X mark in the check boxes on the left side of the field names and select the appropriate Technique for indexing from the dropdown menu at the right top. The most commonly used indexing techniques are 0-by line and 4-by word. Select 4-by word indexing technique in the drop down menu. That means, if you choose 4-by word, all the words in the field will be indexed as indexing terms in the inverted file. Then click Ok to move on to the next screen (Figure 2.23).
Here you can make any alteration in the indexing technique. To correct any entry, just click on the entry in the entries box and that will appear in the edit box as shown in Figure 2.23. You can edit the text and change the indexing technique, if needed. It is better for the beginners to ignore it, initially.

Then click the **Terminate** button (Figure 2.23) and you will get the following message (Figure 2.24).

Now click the **Yes** button for confirmation and you will be notified that the database has been created (Figure 2.25).

Click the **OK** button (Figure 2.25). Now creation of the database is over.
Data Entry

Open the newly created database by clicking on **Open** under **Database** drop down menu (Figure 2.26) as follows:

![Figure 2.26: Open the Database](image)

Then you will get the following screen (Figure 2.27) and select **.MST** file of the new database (audio.mst in this example) from the left pane.

![Figure 2.27: Opening the Database](image)

Click the **Ok** button (Figure 2.27) to open the database as in the following screen (Figure 2.28).
Database definition process is over and you need to enter the data by opening the WINISIS as in Figure 2.29 and by clicking the **Data entry** under **Edit** menu.

You will then get the data entry screen as in Figure 2.30.
Enter the data of the digital audio documents one by one in the fields.

In Audio Field, you need to provide the file name with extension (.mp3, .wav, etc.) alone, if you are going further to create a front end as detailed in the next chapter.
On the other hand, if you provide the full path of the document (e.g., D:\0001.mp3) in the Audio File field and place those documents in that location, you can use the application as a WINISIS archive. A click on the link will then open the audio document.

The database creation is over. You can search and find out required document from the archive\(^7\).

\(^7\)Search mechanism is described in the appendix of this Manual.
GenIsisWeb software can be used for creating a convenient front end for the WINISIS archive. While creating the WINISIS database, you need to use file name alone (not the full path) in the field that contains the link to the document. Here the field name is Audio File.

WINISIS software is already installed in your computer. The database created by WINISIS will work as the back end of the GenIsisWeb application, the creation of which is described below.

The steps for creation of the GenIsisWeb application are as follows:-
- Install Apache web server;
- Install GenIsisWeb software and convert it into English language version;
- The WWWISIS folder from GenIsisWeb installation will normally be copied automatically into HTDOCS folder of Apache. Otherwise do it;
- The contents (not the folder) of BIREME in GenIsisWeb will normally be copied to CGI-BIN in Apache. Otherwise do it;
- Create the GenIsisWeb front end application with a website like homepage;
- The front end can be accessed by an HTTP address.

### Installation of Apache Web Server

Install Apache\(^8\) web server software in your computer\(^9\), to create a convenient front end with GenIsisWeb software. Apache is the most popular free software used for converting a computer into a server. On installation of the Apache software, even the client computer in the network will become a server and the application can be accessed from any remote computer in the network.

---

\(^8\) Apache software is used for making any computer into a file server in the client-server mode. Software Server is the computer that serves the files. Apache HTTP Server software for Windows can be downloaded from http://httpd.apache.org/download.cgi [download Win32 Binary without crypto (no mod_ssl) (MSI Installer)].

\(^9\) By creating the GenIsisWeb application, you can make the digital audio archive accessible over the network.
**Installation Process**
Double click on the icon and installation of Apache will start.

![Figure 3.1](image)

Click on the **Next** button (Figure 3.1).

![Figure 3.2](image)
Here (Figure 3.2) you have to type a domain name (e.g., kila.org), server name (e.g., www.kila.org) and email address (e.g., crstation@kila.org). These names need not be real.

Click the Next button and the following screen will appear (Figure 3.3).

Select Complete (to install all program features) and click the Next button.
While installing Apache, ensure to choose C:\Program Files\Apache Group\Apache as the destination folder for installation. Otherwise it will not match with the defaults set in the GenIsisWeb software.

Click the Next button.

Click on the Install button and you will get the following screen (Figure 3.6).

---

If you are installing the Apache in some other location, please ensure to choose appropriate path of cgi-bin and document root (htdocs) in figure 3.4. As well, you should copy the WWWISIS folder from C:\Program Files\GenISISWeb to …htdocs\ folder in Apache and copy the contents of the bireme folder in GenIsisWeb to the cgi-bin folder in Apache.
Click the **Finish** button, when the installation process is complete.
Once Apache is installed, you can start installing GenISISWeb.

**Installation of GenISISWeb**

GenIsisWeb software can be downloaded\(^1\) as a zip file from Internet and will appear as follows:

![GenIsisWeb zip file](image)

**Figure 3.7: GenIsisWeb zip file**

Double click on it and it will show the following screen. Then suggest a path where you want to copy the unzipped files and click on the **Decompresser** button (Figure 3.8)

![Decompressing GenIsisWeb zip file](image)

**Figure 3.8: Decompressing GenIsisWeb zip file**

When you decompress the zip file, you will get the following three files namely, GENISISWEB.CAB, SETUP.EXE and SETUP.LST (Figure 3.9).

![Decompressed Files](image)

**Figure 3.9: Decompressed Files**

\(^1\)GenisisWeb software can be downloaded from www.scribnet.org or www.unesco.org/isis/
Double click\textsuperscript{12} the setup.exe file shown in Figure 3.9. Then you will get the first screen in the installation process as shown in Figure 3.10.

![Figure 3.10: Installation of GenIsisWeb software](image)

Click the OK button to get the following screen (Figure 3.11).

![Figure 3.11: Starting Installation of GenIsisWeb software](image)

When you double click on setup.exe file, an installation wizard will appear. You can install the program by pressing the return key continuously till the installation is over.
Click on the **Continuer** button (Figure 3.12).

![Figure 3.12](Image)

Then click the **OK** button (Figure 3.13) to finalize the installation.

![Figure 3.13](Image)

### Starting Apache Web Server

Normally the Apache might start running just after the installation or when you open your computer. If Apache is not ON, start the Apache web server, by following the steps given below:

Click **Start** ➔ **Programs** ➔ **Apache httpd Server** ➔ **Configure Apache Server** ➔ **Start Apache in Console**

---

13 During the installation, the WWWISIS folder under the GenIsisWeb will be automatically copied into the HTDOCS under Apache. The contents (not the folder) of BIREME in GenIsisWeb will be copied to CGI-BIN in Apache. Otherwise copy both.

14 Checking the running status of Apache is simple. Open your web browser and type the word localhost in the address bar, you will get a homepage with the words, **It Works**. If you get that homepage, it is sure that the web server Apache is ON.
When Apache starts running, you will get the following window (Figure 3.15). Then click Esc key in the computer or minimize the screen.

![Apache Running Status](image1)

Figure 3.15: Apache Running Status

You can then design your web interface for WINISIS archive using GenIsis Web software.
Converting GenIsisWeb into English

To convert the GenIsisWeb into the English version, open the GenIsisWeb and follow the steps as shown in Figure 3.16.

Then you will get the following screen (Figure 3.17).

The default display language of the GenIsisWeb application is French.

Click on the Configuration → Option and you will get the following window (Figure 3.18). Click the dropdown menu, in the screen, and select Anglais to change the language into English.
Also, select the sub-folder "wwwisis" in "DocumentRoot" and click the side button as shown in Figure 3.19.

Then the following screen (Figure 3.20) with a message in French, asking you whether to use the Apache, will appear.
Click the **Qui** button.

Click the **Valider** button.

Click the **OK** button.
Click the **OK** button (Figure 3.23). Check whether everything is correct as instructed in the screen (Figure 3.23). Now you have to restart GenIsisWeb to get the English version.

**Creating GenIsisWeb Application**

Restart GeinsisWeb by clicking **Start** ➔ **Programs** ➔ **Application GenISIS** ➔ **GenISISWeb**.

Then you will get the following screen (Figure 3.24).

Click on **Application** menu and select **New** (Figure 3.25)
Then the following screen (Figure 3.26) will show the list of WINISIS database available in your computer in its default location.

Select the database (.mst) and click the **Open** button in the screen (Figure 3.26). You will get the following screen (Figure 3.27).

Type any name like **MYWEB** for your application and click **OK**.

---

If your WINISIS data is in any folder other than the default folder (C:\Winisis\Data), choose the .MST file by using the look in drop down menu (Figure 3.26).
Now you will have to design two forms - one Query form and a Search Result Display page by using Format 'listing' as detailed below.

Altogether there are three form design formats:

- **Query form** which allows you to design the web like Query Form - a home page for searching the WINISIS database.
- **Format 'listing'** which allows you to design a Search Result Display Page
- **Format 'details'** is ignored as it serves no purpose, in our case.

We shall use the first two forms for our purpose and ignore the third form Format 'details'.

**Designing the Query Form**

To design the query form, click the **Add** button at the bottom of the query form as shown in Figure 3.28.

![Figure 3.28: Form Design Formats](image)

Then you will get the following screen (Figure 3.29).
In the above screen (Figure 3.29), select **All fields** from the left panel to create a single search box that allows search by any term in any searchable field in the database. Then choose Index and click **OK** button.

You can select your option with regard to the search operators and the index button by clicking the check boxes on the left side of the above screen. Index button would help the users to choose the terms indexed in the inverted file for search.

Now you will get the following window (Figure 3.30). The screen (Figure 3.30) shows the **All fields** search box alone.

---

The items appearing on the left pane of Figure 3.29 are the fields you had included in your WINISIS database. If you want to create a multi-field search box for more fields, you will have to click on **Add** button, select the field from the left pane and click the **OK** button every time until you put search box for each one of those fields.
Select any or all the three tabs **Form**, **Index** and **Page** appearing on the right side of the screen for appropriately modifying the 'look' of the Search-box area, Index Page and Display Area of query form respectively. You can ignore them initially to avoid the trouble of learning inessential things.

You can play with the options in the screen and can choose anything you prefer to have a beautiful look for your web front end. You can change background color, font parameters, etc.

**How to Change the Page Display of the Query Form**

![Figure 3.30](image)

![Figure 3.31](image)
Designing Format 'Listing'

Then click on the 'Format-listing' window at its top and you will get the following screen.

![Figure 3.32: Default Format 'Listing' Page](image)

Click the Add button at the left bottom so as to get the following window (Figure 3.33). You can design your Search Result page, as detailed in Figure 3.33.

![Figure 3.33: Defining Format 'Listing' Page](image)

---

You can choose the format 'listing' or Query form by selecting it from the Windows drop down menu that appears in the opening screen of the application.
In the screen as shown in Figure 3.33, first select the appropriate Field (for display in the search result page) by clicking the drop down menu. Then click the down arrow button at the middle and finally click the Ok button.

Now insert the next Field by clicking Add button till all fields except Audio File are selected. Audio File field needs to be provided with a link to the audio document for opening it.

![Figure 3.34: One Field (Title) Added](image)

Figure 3.34: One Field (Title) Added

Now add the Audio File field as described in Figure 3.35.

![Figure 3.35: Providing Link to the Audio File Field](image)

Figure 3.35: Providing Link to the Audio File Field
Then, click on the **down arrow** button at the middle as shown in Figure 3.35. Then click the drop down menu appearing against **link** and select **To external resource (pdf, doc…)**, in order to link the audio files.

Then provide the path to the subfolder where you put the full-text documents\(^\text{18}\) (e.g., /audio/) in HTDOCS of Apache as shown (/audio/) in Figure 3.36. Now click **Ok** button to save it.

You may move on to the next screen (Figure 3.36).

\[\text{\textbf{Figure 3.36: Format Listing}}\]

While designing two forms (query form and format 'listing'), create a subfolder (say audio) in **htdocs** and copy all the audio documents in that folder.

Then click on Application drop down menu and select **Create application** as in Figure 3.37.

\(^{18}\)You should create a subfolder (choose any name such as audio for the subfolder) in the folder .../Apache/htdocs/and copy all the audio documents in it. The documents can only be placed in a sub-folder in htdocs and the relative the documents in a sub-folder namely pdf in htdocs the path should be /pdf/
Figure 3.37: Create Application

You will be led to the following message (Figure 3.38).

Figure 3.38: Test the Application

Click on the Yes button and the query form you had created will appear as in Figure 3.39.

Figure 3.39: A Test Window - Query Page
Type any search term in the **Search box** for all fields to make a search.

![Search Window](image1.png)

**Figure 3.40: Search Window**

Then click the **Search** button to get the following screen (Figure 3.41) containing the result.

![Search Result Page](image2.png)

**Figure 3.41: Search Result Page**
If you click on the link (001.mp3) provided in the field Audio File (Figure 3.41), appropriate document would be opened, automatically as follows (Figure 3.42).

Figure 3.42: An Opened Audio Document

Close the above windows and save the application as follows (Figure 3.43).

Save the Application
Finally Save the application by clicking the Save under Application drop down menu as in Figure. 3.43.

Figure 3.43: Save the Application
Click the **OK** button as shown in Figure 3.44.

Now, you can open the GenIsisWeb application by typing the http address `http://computername/wwwisis/databasename/form.htm` in the address bar of the web browser, from any computer in the local network.

For example, `http://127.0.0.1/wwwisis/new.01/form.htm` will be the address for the application created above. The computer will add .01 to the first application (new.01) and .02 to second application (new.02) and so on, when you create different home pages for the same database. Any number of applications can be created for the same database.

You can allow others to search the database with the above HTTP address.\(^9\)

\(^9\) If a remote user opens the application from a remote computer, the IP address of the host computer where the application is installed, should be used in stead of 127.0.0.1. The IP number 127.0.0.1 denotes localhost. The localhost is a reserved name meaning this computer in which the browser is running.
Chapter 4
Creation of a CD-ROM Library of Audio Documents

Digital archive of audio documents created with WINISIS in Chapter 2 can easily be ported into a CD-ROM with GenIsisCD software. The CD-ROM library or archive of audio documents, thus created, can be used for wider dissemination and safe storage.

The steps for creation of the CD-ROM library are as follows:

- Create an archive of audio documents using WINISIS with one field for file name with extension (001.mp3)
- Convert the archive into a CD-ROM library with GenIsisCD.

You can use the database created in Chapter 2 for converting into a CD-ROM library or creating a new WINISIS archive ensuring the following essential features. If you choose to use the WINISIS archive already created, then go to the installation of GenIsisCD and continue from there. However, a recapitulation of the important points is given in the following section.

**Important Steps in Creation of a Database of Audio Documents**

Collect the audio documents and create a database of the digital documents in WINISIS with as many fields as required. But ensure to provide the file name with extension (001.mp3) alone in one (Audio File) field.

The database of our demonstration CD-ROM library will have the following tags and fields. But, you can use any tag and field name.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Title</td>
</tr>
<tr>
<td>20</td>
<td>Singer</td>
</tr>
<tr>
<td>30</td>
<td>Film</td>
</tr>
<tr>
<td>40</td>
<td>Format</td>
</tr>
<tr>
<td>90</td>
<td>Audio File</td>
</tr>
<tr>
<td>100</td>
<td>List</td>
</tr>
</tbody>
</table>
Creation of database using WINISIS is very easy as explained in the second chapter. After creating the files in WINISIS for the database, edit the print format of the database as follows for providing a link from a field to the Audio File. This is also explained in the chapter.

**Edit the Print Format**
Open the print format by clicking **Print Format** under **Edit menu** in WINISIS as follows (Figure 4.1).

![Figure 4.1: Original Print Format](image)

Add the following format line in order to create a hypertext link with the words **Click here**. The hyperlink, thus created, will be cross-linked to the audio document, the name of which is provided in the tag number 90:

```
Link (('Click here'), 'OPENFILE ', v90)
```

Ensure to provide a space between the OPENFILE command and the single quote, and the command OPENFILE should be in upper case as shown above.

The meaning of the command is that, when you click on the link in the **Audio File** field, the click will automatically result in opening the digital document denoted in the field v90.

---

The words **Click here** is used to make know the concept of linking and the words have no significance as they do not appear when CD-ROM library is created.
The resultant print format would appear as in Figure 4.2. Click **Ok** button (Figure 4.2) to save the edited print format.

![Figure 4.2](image)

**Figure 4.2**

**Entering Data in the Database**

Enter the data of all documents, such as Title, Singer, Film, Format, etc. in each field\(^1\). The filename\(^2\) of the audio file including extension (001.mp3) should be entered in the **Audio File** field.

Then the database display should be as follows (Figure 4.3)

![Figure 4.3](image)

\(^1\)Please see Chapter 2 to find the way of opening the data entry screen.

\(^2\)Do not provide full path of the audio documents in the Audio File field. Remember that for creating WINISIS archive, full path is required, whereas for creation of a homepage - like front end with GenIsisWeb explained in the second chapter and for creation of CD-ROM library described in this chapter, file name with extension alone is required.
The database creation is over and you can continue with creation of CD-ROM library with GenIsisCD.

**Creation of a CD-ROM Library with GenIsisCD**

**Installation of GenIsisCD Software**

GenIsisCD1.1.0 software is available at www.scribnet.org. When you download it will be in zipped mode. Unzip the downloaded zipped file and you will get the following three files.

![Figure 4.4](image)

Double click the setup.exe file given above. Then you will get the first screen in the installation process as follows (Figure 4.5).

![Figure 4.5](image)

Click the OK button and you will be led to a screen as in Figure 4.6.

---

23 The GenisisCD software created by Pierre Chabert (pichabert@wanadoo.fr) is available at http://www.scribnet.org. Download the English version.

24 When you double click SETUP.EXE, an installation wizard will appear and you can install the program selecting the default values in the wizard by pressing the return key, all the time, till the installation is over.
Click the computer icon to continue

Figure 4.6

Click on the computer icon on the left side and you will get the following screen (Figure 4.7).

Figure 4.7

Click the Continue button and you will be notified the successful installation of the program.
Click on the **OK** button to finalize the installation.

**Creation of CD-ROM Library: Further Steps**

Open GenIsisCD program and you will get the following screen (Figure 4.9).

Then you will get the following screen as in Figure 4.10.
Click **Configuration** and select **Options** to get the following screen (Figure 4.11).

![](image)

**Figure 4.10**

Click here to select the language as English.

**Figure 4.11: Selecting English as Default Language**

Click on the language drop down arrow key to select the language English and click the **Ok** button as above. The screen shown in Figure 4.12 will appear.

Click on the **Application** menu (Figure 4.12) and select **New** as follows.

If your installation doesn't show English language, create a notepad file with the following contents.

```plaintext
[OPTIONS]
LANG=en
```

Save it with the name *GenIsisCD* and put it in the folder `C:\Program Files\GenIsisCD`. The application will be converted to English when you refresh it.
Then the screen (Figure 4.13) will appear, if the WINISIS database is available in the default location.

Select the .MST file of the modified WINISIS database and click the Open button in the above screen. The following screen (Figure 4.14) will appear.
Give a name like **MYWEB** for your application and click OK (Figure 4.14).

Now you will have to design two forms - one Query form and a Search Result Display page by using Format 'listing' as detailed below. There are three form design formats as listed below:

- **Query form** which allows you to design the web like Query form - a homepage for searching the WINISIS database.
- **Format 'listing'** which allows you to design a Search Result Display Page.
- **Format 'details'** is ignored.

We shall use the first two forms for our purpose and the third form Format 'details' will be ignored.

![Figure 4.15: Form Design Formats](image)

**How to Design the Query Form?**

*Query form* is the front-end web form, like the homepage of a website. It will have a search box, submit button and other buttons. To design the query form, select the **Query form** by clicking on it.
Click here to Add search box

Figure 4.16: Designing the Query Form

Then, click on the Add button at the bottom of the query form to add a search box and an index button. Then you will get the following window (Figure 4.17).

Check here to create Index button

Figure 4.17: Adding Search Box to Query Form
In the screen as shown in Figure 4.17, select 'All fields' from the left panel (as it allows search by any term in the database) and then click Ok. Now create an index button by marking the appropriate check box.

Next you will be led to the following window (Figure 4.18), which allows you to modify the colour and appearance of the form.

The items appearing on the left panel are the database fields included in the Winisis database and you can create search box exclusively for each field by selecting the field one by one and clicking Ok.
How to Change the Page Display of the Query Form

Click here to change background colour

Click on this button to edit the title of your query form

Put tick mark to show the number of records to be displayed in a search.

Figure 4.19

Many inbuilt options are there (Figure 4.19). You can play with these options and can change anything you would prefer to have a beautiful look for your CD-ROM library.

Designing Format 'Listing'

Now click on the 'Format-Listing' window and you will get the following screen (Figure 4.20). So we need to create the page.

Figure 4.20: Changing the Appearance of the Search Result Display Page
Click the **Add (✓)** button at the bottom to create a customized search-result display page and you will get the following window (Figure 4.21).

![Figure 4.21: Creating a Search Result Display Page](image)

From the screen (Figure 4.21), select the appropriate **Field** in the drop down menu and then click the **down arrow** button at the middle and then click the **Ok** button. Now select the next field by clicking the Add (✓) button till all **Fields** except the field **Audio File** are added (Figure 4.22).

![Figure 4.22](image)

Select the **Audio File** field (Figure 4.23) and provide a link as follows.

---

If you don't **Add** any field, the default search result display page will appear. But the default page will not have links to the **Audio file** field.
Then click on the down arrow button at the middle so as to display the Audio File name with extension (001.mp3). Now select the drop down menu appearing against link (Figure 4.23) and select To external resource (pdf, doc...), if the audio documents are mp3, wav, pdf, doc, html, etc. Then click the Ok button to save it. Then move on to the next screen (Figure 4.24).

After designing two forms (Query Form and Format 'Listing') as in Figure 4.24, you may click on the Application drop down menu and select Create application as in Figure 4.25.
Figure 4.25: Creating Application

On clicking the Create Application, you will get the following screen (Figure 4.26).

![Create Application Window]

Figure 4.26

Click the OK button (Figure 4.26).

Now your application is created in the folder C:\Program Files\GenIsisCD\appli\Cd.01. (The second application will have the name Cd.02, third one will have Cd.03 and so on). Now you may test whether the database is working properly before finalizing the CD-ROM application.

---

In order to test the application, open the html folder (C:\Program Files\GenIsisCD\appli\Cd.01\html) and Delete the index file (index.htm). Then open the base_databasename_01 (e.g., base_audio_01) folder (C:\ProgramFiles\GenIsisCD\appli\Cd.01\html\base_databasename_01). Copy form_databasename (e.g., form_audio) file and paste it in the html folder and rename the copied file (in the html folder) into index. Then click the Navisis.exe file (C:\Program Files\GenIsisCD\appli\Cd.01 folder. Now you can see the query page and can search the database, but the link to Audio file will not work.
Finalize the CD-ROM Application

Click on the Application drop down menu and select Finalize the application (before “CD burning”) as in Figure 4.27. Then you will be led to the following screen (Figure 4.28).

![Figure 4.27: Finalize CD-ROM Application](image)

You may put a tick mark on the check box on top left so as to make the CD-ROM Auto Run. Then click Ok button and move on to the next screen (Figure 4.29).
Click **Yes** in the screen (Figure 4.29). The next screen (Figure 4.30) appears.

![Figure 4.29](image)

Click the **OK** button in the above screen, in order to move the database to C:\Program Files\GenIsisCD\appli\CD.01\db\audio.

![Figure 4.30](image)

Allow the above screen (Figure 4.31) to run, until it is finished.

![Figure 4.31](image)
Now click the **Close button** (X) to get the following screen (Figure 4.32) with instructions to burn the CD-ROM. Please take a print-out of the page and follow the instructions. 

Click **Exit** to close the CD-ROM file generation process.

![Figure 4.32: Instructions to Burn the CD-ROM](image)

### Modifications to be Made before Finalizing the CD-ROM

Open the **html** folder (C:\Program Files\GenIsisCD\appli\Cd.01\html) and Delete the **index** file (index.htm).

Then open the **base_databasename_01** (e.g., base_audio_01) folder (C:\ProgramFiles\GenIsisCD\appli\Cd.01\html\base_databasename_01).

Copy **form_databasename** (e.g., form_audio) file and paste it in the *html* folder and rename the copied file (in the html folder) into index.

Create a new subfolder (say **audio**) in the "html" directory. Then copy the set of your **audio documents** to the **audio** subfolder (C:\ProgramFiles\GenIsisCD\appli\Cd.01\html\audio.)

### Making the CD-ROM Independent of CD-ROM Drive Label

Make the resultant CD-ROM to work in a computer with any CD-ROM drive label such as D, E, F, etc. as follows.
Open the `liste_databasename` file in the `base_databasename` folder.
(C:\ProgramFiles\GenIsisCD\appli\Cd.01\html\base_databasename\liste_database
name) and it will look as follows (Figure 4.33).

![Figure 4.33: Right Click to View Sources](image)

**Right click** on the page with the mouse and select **View sources** to see the html codes of the page. Then **html codes** will appear in a notepad file as in figure 4.34. Now, you have to find out the html source line pertaining to the field tag, which provides link to the full text documents (in this database 90 is the field tag). The html source line can be found out easily by searching for the * using the **Find** menu of the notepad. Then add the words `[Rep]audio/` in front of the * mark, appearing just before the field tag number and the resultant line would look as follows:

```
<{a target="_blank" href="[Rep]audio/*">[90]</A></B></font><BR>
```
If you provide this syntax `[Rep]`, it will replace the label of the CD-ROM drive of the computer where CD-ROM is put, even if it is D, E or F. The symbol * (star) will replace the name of the audio document file mentioned in the field 90.

Save the changes.

Then burn the contents in the folder `Cd.01` (C:\Program Files\GenIsisCD\appli\Cd.01) on a blank CD-ROM.

### Testing the Burned CD-ROM

#### Installing the CD-ROM

Put the burnt CD-ROM in a computer and the following screen (Figure 4.35) will appear automatically. If the Autorun feature does not work, open the CD-ROM drive to get the following screen (Figure 4.35).
Click on the **Install the CDROM** button shown in Figure 4.35 and follow the on-screen instructions to install the program.

**Running the CD-ROM**

Then go to **Start → Programs → CDROM_name → query the CDROM_name** to open the query form as follows (Figure 4.36).
Figure 4.37: Search Page of GenIsisCD

Type any search term in the **Search box** for all fields to make a search.

Figure 4.38: Search Window

Click **Search** button to get the following search result.
If you click on the link (001.mp3) appearing against the field Audio File provided above, appropriate document would be opened automatically.
Introduction
Community radio managers can also use Greenstone Digital Library Software (GSDL) for managing digital audio documents. The digital library would help them retrieve any document from the multitude of audio documents easily and instantaneously as needed.

The Greenstone offers exciting ways to build manage and distribute digital audio documents. The audio documents can, not only be archived in the computer, but also be published on the Internet or on CD-ROMs using Greenstone Digital Library Software. After making some simple changes in configuration, one can build an audio digital library collection with different browsing classifiers (such as title, creator, etc.) for any digital audio document collection. Once initiated, the automatic collection building process may run into several hours or days for a very large audio document collection. One can organize digital audio documents into focused collections under different categories for instantaneous retrieval and use.

Software Installation
All the software tools needed for installation and running of Greenstone is available in Internet. The website location of the software in the internet is provided in the footnote.

Installation of the Software
Installation of the software is very easy. The wizard will guide you through the process of installation by suggesting the default options.

------------------
29 The Greenstone Digital Library Software (Windows) version 2.80 is the current one and can be downloaded from http://www.greenstone.org/ or http://greenstonesupport.iimk.ac.in/downloads.htm.
Java2 Runtime Environment can be downloaded from http://java.sun.com/
Install **Java2 Runtime Environment** in your computer as a prerequisite before installing GSDL software. The installation will be a straightforward one, if you are choosing the defaults in the wizard.

Then, install the **GSDL 2.80 (Windows version)** software in your computer. Choose, preferably, the Local Library mode of installation which uses an inbuilt web server for running the application. Web library installation, on the other hand, will help you make the collection easily accessible in the local network. It requires a separate web server like Apache / IIS and slight modification in the configuration file needs to be done to make the Web Library work.

While installing the software, just choose the default options shown by the wizard. The Greenstone installation Manual available in Internet sites mentioned above will help you know more about the installation process. The Local Library installation can be accessed from the Start menu whereas the Web Library installation can only be accessed from a web browser using an http address.

Before starting the collection building process, please ensure that the audio documents, to be built up, are placed in a suitable folder in the computer.

**Building up a Collection with GLI**

The easiest way to build a new digital library collection is to use Greenstone's Librarian Interface** (GLI), a component of Greenstone Digital Library Software. GLI allows one to collect the documents, import or assign metadata, and build the documents into a digital library.

GLI can perform the following basic functions, while building up a collection:

1. **Gather** documents for building up the collection
2. **Enrich** the documents by adding metadata
3. **Design** the collection, its appearance and the access facilities
4. **Format** the appearance of the digital library

GLI is a Graphical Interface program created for making the collection building process easier for anyone who do not have much knowledge to configure a collection. It works in four modes - Library Assistant, Librarian, Library System Specialist and Expert. Librarian is the suitable choice for beginners and is the default mode. When you go up to the level of Expert, you will get more options to build. You can go to file preference to change the mode.
5. Create the collection
6. Convert the digital library into a CD-ROM library

Starting the Building up Process
Open the GLI from the Start ➔ Programs ➔ Greenstone Digital Library Software v2.80 ➔ Greenstone Librarian Interface.
To start a new collection, choose New from the File menu (Figure 5.1).

![Figure 5.1: Starting a New Collection](image1)

Fill up a name for the collection (against Collection title) and a brief description about the collection (against Description of content) in the appropriate column in the pop-up window.

![Figure 5.2: Adding Information about the Collection](image2)
Choose **New Collection**\(^1\) in the **Base this collection** on dialogue box and click **OK** (Figure 5.2).

**Gather the Documents**

Now the **Gather** panel will become active and allow to collect the documents by exploring the computer. You can select the files or directories by browsing the folders in the computer, from the left pane. Drag and drop them into the right pane by your mouse. You can drag the documents either individually or as group of documents in folders/subfolders.

When you gather the documents, the software usually prompts you for adding the **Plug-in**\(^2\), if suitable **Plug-in** is not included. In such cases, please click the **Add Plug-in** button and the appropriate plug-in will be added.

---

\(^1\) This choice indicates that the collection, being built, will have an entirely new structure. If you want your present collection to follow the pattern of an already existing collection, select the name of that collection from the drop-down menu.

\(^2\) Plug-in is an add-on or auxiliary program that works with a major software package to enhance its capability. Here the plug-ins help the Greenstone to handle the digital documents while building the collection. MP3 Plug-in is the specific one used to build audio document collections. Plug-ins, written in Perl language, will translate the source document into a common form, parse them and extract metadata from them.
**Enriching Documents with Metadata**

The next stage is to enrich the documents by adding metadata for each document. Click on **Enrich** tab (Figure 5.3) and it will bring up a panel. The left side of the panel under Collection tab shows the files. The right side, on clicking the Value box of the metadata field, will allow adding metadata for each document against each metadata element such as Title, Creator, etc. Here we use Dublin Core metadata and that is why `dc` - the short form of Dublin Core - is prefixed with name of metadata elements such as Title, Creator, etc.

Select the individual document and add metadata such as Title, Singer, Film, Creator, Subject, etc. of each of the audio documents manually. Any Dublin Core metadata element can be labeled as anything else. So identify the metadata such as author, title, music director, film or similar elements of the audio documents in common and choose an appropriate one for each of them from the Dublin Core metadata while adding the value.

The Greenstone will allow using any label for any metadata. So you can use dc.Title as metadata element and provide it with a label Title. Like that, you can use any metadata element such as dc.Creator, dc.Contributor, etc. and can provide any other labels such as Author of the song, Music director, etc. for those metadata.

For making it simple, we use Author, Title and Subject of the songs as metadata elements in this Manual. But you can use any number of elements as metadata and can use any label for any Dublin Core metadata.

---

33 Metadata is the data about the documents, such as Title (of the song), Singer, Film, Format and so on. The metadata element pre-fixed with dc. (e.g., dc.Title) denotes Dublin Core metadata, ex. (e.g., ex.Title) denotes extracted metadata, exp. (e.g., exp.Title) denotes exploded metadata. Here we use Dublin Core metadata and provide value against the metadata element after selecting each document file name under collection on the left pane.
Type the Title of the audio file against `dc.Title`, type the Creator (Author) of the song or program against `dc.Creator`, and type the Subjects (Keywords) against `dc.Subject` and Keywords for each document appearing below Collection tab (left pane) as in Figure 5.4. You can include more browsing classifiers of your choice, if required.

**Design the Collection**

Now, design the collection by choosing the features available under the Design menu. Design of the collection can be done by many submenus that are available on the left side pane.

**Document Plug-ins**

Click on Document Plug-ins on the left pane (Figure 5.5) to add the required Plug-ins needed to convert the audio document into the Greenstone collection. All plug-ins, needed for handling common documents, will be loaded by default at the time of installation. If proper Plug-in is not loaded, the software cannot build the digital audio collection. So please add **MP3 Plug-in**, while building the digital collection of audio files.
Create Search Indexes

Choose **Search** indexes, shown in Figure 5.6, for creating Search Indexes. Search Indexes can help you search and retrieve audio documents based on the words appearing in selected metadata elements such as Title, Creator, etc.
**Remove Default Indexes**

Remove the default indexes for ex.Title and ex.Source by selecting the index description under Assigned Indexes and then by clicking on the **Remove Index** button (Figure 5.7). Remove the Search Index for **text [Default Index]** as the documents have no text at all.

**Figure 5.7: Removing Default Index**

**Adding New Indexes**

Click on the **New Index** button (Figure 5.8). Select the **dc.Title**, **dc.Creator** and **dc.Subject** and **Keywords**, by tick marking on the nearby check box, and add them one by one by clicking on the **Add Index** button. That means select dc.Title first, add it and then select dc.Creator, add it and continue like that. You can confine the creation of search indexes for essential metadata elements alone.
At the end, all the three indexes will be added one by one as in Figure 5.9.

You may select an index and move it up or down by clicking on the buttons on the right side so as to set the order of its appearance. Likewise you can set any index as default index by using the **Set Default Index** button.
Browsing Classifiers

In order to facilitate browsing of audio collection, we need to set up Browsing Classifiers such as Title, Creator/Author, Subject, etc. of the audio documents to browse the collection.

For that, remove the default Browsing Classifiers, for Title and Source as shown in Figure 5.10, listed under the Assigned Classifiers panel by clicking on it one by one and then by clicking on the Remove Classifier button.

The default browsing classifier for Title represent the extracted title (ex.Title) and the Dublin core title (dc.Title) which we are using is different.

Use of AZCompactList Classifier brings icons for a shelf of documents under the browsing classifier. It groups together the documents that appear multiple times with same metadata and does not differ from AZList in any other manner.

All Dublin Core metadata elements have default buttons and the button names will be assigned automatically. Title, Creators and Subjects are the default button names for dc.Title, dc.Creator and dc.Subject and Keywords. You can change the button name by marking the check box for button name and typing the new button name against it, while configuring the browsing classifiers. It is better to use the default button name initially, so as to avoid the complexity.

Now, choose Select classifier to add pull down list and select A-Z List or A-Z Compact List. Then click on Add Classifier and add the Browsing Classifiers for dc.Title, dc.Creators and dc.Subjects and Keywords by one by one.
When you click **Add Classifier** button in the screen (Figure 5.11), you will get the window for choosing the **Browsing Classifier**. Select the Browsing Classifier for Title by choosing the metadata (dc.Title) as follows (Figure 5.12).

To provide the button name, scroll down the configuring arguments a little below, find out the button name box, check mark it and type the desired Button name or label for Browsing Classifier. Then click **OK** button to add Title classifier. Then select the browsing classifier for Creator by choosing the metadata option (dc.Creator) as follows (Figure 5.13).
Click **OK** button (Figure 5.13) to add Creator classifier. Then select the Browsing Classifier for Subjects by choosing the metadata option (dc.Subject and Keywords) as follows (Figure 5.14).

Click **OK** button to add Subject and Keywords classifier. The resultant screen that shows the three added Browsing Classifiers will appear as follows (Figure 5.15).
Figure 5.15: Browsing Classifiers Assigned for the Demo Collection

**Format**
The page display of the resultant digital library, including the display page that appears on clicking the browsing classifiers or on making a search, are governed by the features provided below the Format tab. Format can be used for the following general designs (Figure 5.16).

**General**
Choose the Format Tab and select General to provide the general description about the collection (Figure 5.16). The description will appear in the opening page of the collection.

**Put a Picture as a Collection Icon**
Choose a small picture of around 100*100 pixels, click on the **Browse** button (Figure 5.16) on middle right and select the picture. Then the full path of the picture will be as displayed in the address box lying against the **Browse** button. The picture will appear as collection icon in the homepage of the Greenstone and a click on the picture will take you to the 'about page' of the collection.

---

85

*If the picture is large, its appearance in the about page will be larger taking upper half of the display.*
You can provide the same picture or a different picture as the image for the 'about page' also. It is advisable to avoid the picture in the 'about page' for convenience in use.

**Figure 5.16: Designing the Collection  General Information**

**Format Features**

Beginner's may skip the Format Features section (Figure 5.17) and go to the next section (Build the collection) (Figure 5.19). When you skip, the default settings will take care of the page display. Advanced users can use the Format Features section of the Format panel on the left pane for modifying the display of audio documents to some extent.

About page is the first page about an individual digital library collection that contains a short description about the collection.

There are two types of Format Statements - General statement applicable in general to all and specific statement applicable to specific classifier or search list. Specific statements, if present, would override the general statements.

Let us examine some statements:

VList - applies to all vertical lists in all classifiers
Search VList - applies to all search result lists
CL2HList - applies to all hierarchy lists in classifier 2

The value of any metadata can be interpolated, by putting it in square brackets. e.g., [Title], in the format statements.
If you want to change any format feature, select the appropriate one (e.g., CL1 AZList- metadata dc.Title) from the **Choose Feature** pull down list (Figure 5.17) and add the format string to the Format Features by clicking on the **Add Format** button.

You can select any feature appropriate for changing the appearance of the digital library.

Fresh users may find it difficult to learn the format features in the beginning stage. But a little learning will enable you to manage the formatting easily.

The CL1 Browsing classifier\(^\text{40}\) for Title can be added as shown in Figure 5.18.

---

\(^{40}\) CL1 denotes the first browsing classifier dc.Title and CL2 denotes the second one dc.Creator and so on.
Similarly, select any other string from Choose Feature box and click Add Format button for editing and customizing it, as displayed in the above screen. You can edit the HTML strings under the Format Features box by selecting it and editing them in the HTML Format String box appearing below.

You can add CL2 and CL3 classifiers for Creators and Subjects and keywords and can make modifications, if you have reasonable knowledge of HTML.

**Building the Collection**

Let us go to the Create panel now (Figure 5.19). Click on the Build Collection button and the progress bar will display the progress in building the collection.

![Click here to build collection](Figure 5.19: Building a Collection)

**Preview the Collection**

At the end of the building process, Click on the Preview Collection button to view built up the collection (Figure 5.20). Then next screen appears as shown in Figure 5.21 to navigate the collection by Title Classifier.
Converting the Collection into a CD-ROM

You can export the collection/collections to a CD-ROM, in order to convert your Greenstone application into an installable CD-ROM, for distribution among wider constituency of audience.

Click on File ➤ Write CD/DVD image..... (Figure 5.22).
Figure 5.22: Starting the Export Process

A pop-up window will appear as follows (Figure 5.23).

Figure 5.23: Giving a Collection Name for CD-ROM

Provide a name for your CD-ROM, mark the check box pertaining to the collection to be exported and click Write CD/DVD image button.
Figure 5.24: Export Completed

After completing the export process, click Close button.

Then write the contents of the folder (C:\ProgramFiles\Greenstone\tmp\exported_Demo) into a blank CD-ROM for creating self-installing Windows CD-ROM. Please remove the gsld.cfg file from the contents, before browsing the contents into a CD-ROM, if the file is there in the contents.
Conclusion

The basic Greenstone Audio Library with normal look and feel can be created within a few minutes. The digital library collection, created thus, can be customized later in a variety of ways. The customization can be done, whenever you like, by opening the collection, which can be done by clicking on the menu, File → Open and selecting the appropriate collection name in the GLI.

Greenstone is useful software to archive and retrieve digital audio files in our community radio stations. For that the managers of community radio should learn a little about the greenstone software and use them for managing audio documents. Greenstone will help you manage your audio documents easily.

Further Readings

- Apache HTTP Server Documentation <http://httpd.apache.org/docs/>
- Greenstone Manuals <www.greenstone.org/manuals/gsdl2/>
- Greenstone Support for South Asia Documentation <http://greenstonesupport.iimk.ac.in/documentation.htm>
Annexure

Modifying a WINISIS Database

The WINISIS database once created can be modified, in case of emerging needs. The method of modifying various components of WINISIS database is given below.

1. Adding or Removing a New Field in the Database

After creating a database, you may feel the need to add or remove fields in the database at times. That can be done by modifying the Field Definition Table as described below:

**Adding a field**

Open the database.

Choose **Edit ➔ Field Definition Table** from the drop down menu.

This will open up the **Database Definition-Field Table** window. The cursor will be in the Tag box.

To add a field, type the **Tag Number**, press {tab} to move the cursor to the **Name**.

Then type the name of the **Field**, leave the next box as **Alphanumeric** and click the check box, if the field needs to be repeatable, with provision to enter the data more than once against the field.

Click on the **Add** button.

Then click the **Ok** button when you finish and **Save** it.

If you add a new field, that needs to be added to the **Data Entry Worksheets, Print Format** and **Field Selection Table** for proper working of the modified database.

In Data Entry Worksheet and Field Selection Table, you can add a field easily whereas in Print Format, you cannot add a field. Instead create a new **Print Format**, delete the earlier one and rename the new one with the name of the earlier format.
Removing a Field from the Database
You can remove a field, by opening the Field Definition Table of the database, selecting the Field and clicking on the Delete Entry button.

2. Modifying the Data Entry Worksheet
Select Edit ➔ Data Entry Worksheets.
The added field will be displayed on the Fields window on the left pane.
Double click on the new field and that field will be added to Data Entry Field box on the right. Now your database will be ready to accept the data in the new field.

3. Modifying Field Selection Table
Open the database
Select Edit ➔ Field Selection Table
Choose the field from the drop down menu shown against the Tag/Name
Choose the Technique from the drop down menu
Click Add and Click Ok to save it
You can edit the Entries by double clicking on it and moving it on to the Format box.

4. Creating a New Print Format
Select Edit ➔ Print Format
Select New
Give a new Name for print format
Click the Ok button to create a new print format
Then Print Format Assistant will be launched. Choose a format from among five choices of print formats, click Ok and save it. In order to make it as default, delete the earlier format and rename the new one with the name of the database.
5. Modifying the Print Format

Print format (.pft) determines the manner in which the database records are displayed. The default Print format must have the same filename as the database. So in order to make another print format as the default print format, change the file name as that of the database name.

In Print format, fields are specified by using v in front of the tag. e.g v10.

Text between single or double inverted commas will appear as it is, in the display. e.g., "Author:"

Slash (/) will start a new line.

In the Print format, you can use conditionals as follows:

IF v80='BOOK' THEN v10/v20/v30 ELSE IF v80='ARTICLE' THEN v20/v30/v40/v50. It means if v80 is 'Book' print v10/v20/v30 or else if v80 is 'Article' print v20/v30/v40/v50

You can use the name of a print format fmt1.pft and fmt2.pft as follows:

IF v80='BOOK' THEN @fmt1 ELSE @fmt2

If you provide a line Link ('"Go to the website"', 'OPENFILE ', v40) in Print format and give the web address of the site (say www.kilaonline.org) in v40, a link will appear with the words Go to the website. A click on the hyper link will take you to the website, if the computer is connected to the internet.

If you provide a line Link ('"Show a picture"', 'OPENFILE ', v40) in Print format and give the path of the image file in v40, a link will appear with the words Show a picture. A click on the link will open the image file. This feature has been made use of for creation of digital archives, in this Manual.

6. Modifying the Data Elements in a Database

You can change the data in a range of records (e.g., mfn 200-350) or entirely in a database by:

- **Global Add** - adding a piece of data in a field, in every record
- **Global Delete** - removes a piece of data from a field, in every record
- **Global Replace** - replaces selected text in a field, with another text
6.1 Global Add

Open Database
Select **Utils** ➔ **Global Add**
Enter the range of MFNs e.g., 10/350
Select the field tag using the spin box
Type the text in the box at the bottom so as to be added to the field.
Click **Ok** and then a progress window will come up

6.2 Global Delete

Open database
Select **Utils** ➔ **Global Delete**
Enter the range of MFNs e.g., 2/362
Select the field tag by clicking the spin box
Press **Ok** to see that the field will be deleted from every record selected

6.3 Global Replace

Open database
Select **Utils** ➔ **Global replace**
Enter the range of MFNs e.g., 8/321
Enter the text in the **Text to find**
Enter new text in the **New text box**
Enter **Tag number** (You can specify one or more fields)
Click **Ok** to replace the text

7. Moving Data from One Field to Another by Export/Import Process

You can move data from one field to another, by using Export/Import, as follows. It can be done by **Export** and **Import** of data with a **Reformatting Field Selection Table (FST)**. You need to create an **FST** for this purpose first and then to Export or Import the database with that reformatting FST.
7.1 Creating a Reformatting FST

Reformatting FST is the Field Selection Table that enables to change the fields of a database into a different set with new tags and field names.

Choose **Edit ➔ Field Selection** Table Select **New** button

Enter a name for **FST** e.g., CONV

Then the database definition-extraction tables will be opened.

Select the fields of the database from which you want to move the data to a new one, Delete other fields and save it.

Edit the **FST** in such a way that the **Destination Field Tags** (e.g. 100, 200) would appear in the left and the field tag from where you move the data would appear in the third row (12, 13) as follows:

```
CONV.FST
100 0 V12
200 2 V13
```

Save the above FST and **export** and **import** the database using the above said Reformatting FST.

7.2 Export and Import using the Reformatting FST

Choose **Export** under **Database**

Put the **Reformatting FST** in the **Work** folder

Put the name of the **Reformatting FST** in the Export dialogue box

Click **OK** to **Export** the database as **.ISO** file.

Then import the exported **ISO** file again as WINISIS database

The fields **12&13** would have changed to **100&200**.
**Apache**: A free web server used to manage around 70 percent of the websites in Internet.

**CDS/ISIS**: Computerized Documentation Service/ Integrated Set of Information Systems.

**Client/Server mode**: A computer network model so popular in Internet where the client- a web browser - places a request and the server - a web server - serves the pages requested.

**Home page**: A page that acts like a front door to the content of a website.

**HTTP**: The short form for hyper text transfer protocol. It is a sort of language or set of rules used to communicate between a server and browser.

**IP Address**: The address of a particular computer in a network which has a numerical address ranging from 0 to 255. (e.g., http://100.0.0.60) containing four groups of three digits.

**Link**: A highlighted word that has a connection to a target page and a click on the link will open the target page.

**MP3**: A compressed sound file meant for easier electronic distribution and it occupies only 10 percent of .wav sound files.

**Protocol**: A set of commands/rules that determine how two computers communicate with each other. http, ftp, TCP/IP etc are common protocols used in internet.

**Query**: Any request for information from a database.

**Query form**: A submit form where you can type a query as in the homepage of a website.

**TCP/IP**: The short form for Transfer Control Protocol and Internet Protocol. This protocol governs the sending of data from one computer to another computer in internet or a local network.
**Web Browser:** A software used for viewing WebPages. It is needed to display the pages held in a web server. Internet explorer and Mozilla Firefox are the most popular web servers.

**Web Server:** A computer in the internet/intranet that stores websites and serves the documents stored in the computer on search requests made through a web browser.

**Website:** A location in the World Wide Web identified by a web address such as www.kilaonline.org. Websites are stored in server computers loaded with web servers.

**WINISIS:** CDS/ISIS for Windows.